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1. Manual Information 
 
This Windows Driver Installation Manual provides information on installation, detailed 
specifications, and usage of the printer’s Windows Driver according to PC operating 
system (OS). 
 
We at BIXOLON maintain ongoing efforts to enhance and upgrade the functions and 
quality of all our products. In following, product specifications and/or user manual content 
may be changed without prior notice. 
 
 
 
 

2. Operating System (OS) Environment 
 
The following operating systems are supported for usage. 
 

Microsoft®  Windows XP SP3 (32bit)  
Microsoft®  Windows XP SP1 or later (64bit)  
Microsoft Windows Server 2003 SP1 or later (32bit/64bit) 
Microsoft Windows VISTA (32bit/64bit) 
Microsoft Windows Server 2008 (32bit/64bit) 
Microsoft Windows Server 2008R2 (64bit) 
Microsoft Windows 7 (32bit/64bit) 
Microsoft Windows 8 (32bit/64bit) 
Microsoft Windows Server 2012 (64bit) 
Microsoft Windows 10 (32bit/64bit) 
 
* Serial and parallel printer port do not work on Windows 10 version 1511 (10.0.10586) 

specific. 
 
 
 
 

3. Windows Driver Preparation 
 
The Windows Driver is included in the enclosed CD, and Latest file versions can be 
downloaded from the BIXOLON website. (www.bixolon.com) 
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4. Windows Driver Installation 
 

4-1 Installing on Windows XP / Server 2003 
 

4-1-1 Via Serial Port or Parallel Port 
 
1) Double-click the Windows Driver installation file. 
 
2) Click Next. 
 

 
 
3) Select a COM or LPT port to be used, and then click Next. 
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4) Click Yes to reboot the PC. 
 

 
 
5) Open the printer properties window in the Windows OS. 

※ Control Panel – Printers and Faxes. 

 
6) In the Ports tab, click Configure Port. 

※ Skip this step if you selected a LPT port. 

 
7) Match the communication settings to those of the printer. The communication settings of 

the printer can be performed by conducting a self-test. 

※ Skip this step if you selected a LPT port. 
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8) Click Print Test Page and check printing status. Proper installation of the driver is 
indicated if the test page is printed normally. 
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4-1-2 Via USB Port 
 
1) Double-click the Windows Driver installation file. 
 
2) Click Next. 

 

 
 
3) Select USB and then click Next. 
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4) Click OK. 
 

 
 
5) Turn off the printer and then turn it on. The printer driver will be installed automatically. 
 
6) Open the printer properties window in the Windows OS. 

※ Control Panel – Printers and Faxes. 

 
7) Click Print Test Page and check printing status. Proper installation of the driver is 

indicated if the test page is printed normally. 
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4-1-3 Via Ethernet Port 
 
1) Double-click the Windows Driver installation file. 
 
2) Click Next. 
 

 
 
3) Select Ethernet. 
 
4) Enter the IP address and port number, and then click Next. 
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5) Click Yes to reboot the PC. 
 

 
 
6) Open the printer properties window in the Windows OS.  

※ Control Panel – Printers and Faxes. 

 
7) In the Ports tab, click Configure Port…. 
 
8) Match the communication settings to those of the printer. 
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9) Click Print Test Page and check printing status. Proper installation of the driver is 
indicated if the test page is printed normally. 
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4-2 Installing on Windows VISTA / Server 2008 / 7 / 8 / Server 2012 / 10 
 
4-2-1 Via Serial Port or Parallel Port 
 
1) Double-click the Windows Driver installation file. 
 
2) Click Next. 
 

 
 
3) Select a COM or LPT port to be used, and then click Next. 
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4) Click Yes to reboot the PC. 
 

 
 
5) Open the printer properties window in the Windows OS. 

※ Control Panel – Hardware and Sound – Device and Printers. 

 
6) In the Ports tab, click Configure Port. 

※ Skip this step if you selected a LPT port. 

 
7) Match the communication settings to those of the printer. The communication settings of 

the printer can be performed by conducting a self-test. 

※ Skip this step if you selected a LPT port. 
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8) Click Print Test Page and check printing status. Proper installation of the driver is 
indicated if the test page is printed normally. 
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4-2-2 Via USB Port 
 
1) Double-click the Windows Driver installation file. 
 
2) Click Next. 

 

 
 
3) Select USB and then click Next. 
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4) Click OK. 
 

 
 
5) Turn off the printer and then turn it on. The printer driver will be installed automatically. 
 
6) Open the printer properties window in the Windows OS. 

※ Control Panel – Hardware and Sound – Device and Printers. 

 
7) Click Print Test Page and check printing status. Proper installation of the driver is 

indicated if the test page is printed normally. 
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4-2-3 Via Ethernet Port 
 
1) Double-click the Windows Driver installation file. 
 
2) Click Next. 

 

 
 
3) Select Ethernet. 
 
4) Enter the IP address and port number, and then click Next. 
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5) Click Yes to reboot the PC. 
 

 
 
6) Open the printer properties window in the Windows OS. 

※ Control Panel – Hardware and Sound – Device and Printers. 

 
7) In the Ports tab, click Configure Port…. 
 
8) Match the communication settings to those of the printer. 
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9) Click Print Test Page and check printing status. Proper installation of the driver is 
indicated if the test page is printed normally. 
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5. Windows Driver Settings 
 
The following functions can be configured after installing the Windows driver. 
 
5-1 Layout 
 

 
 

1) Open the Printer Properties window for the corresponding OS. 
 
2) In the General tab, click Preferences (Printing Preferences).  
 
3) Click the Layout tab. 
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5-1-1 Paper Size 
 

Paper size of 80 x 3276 mm is selected by default, and the following sizes can be selected.  
 

80  40 mm 80  160 mm 80  3276 mm 

80  80 mm 80  200 mm  

80  120 mm 80  297 mm  

 
If a custom paper size is required, click “…” to add or update a custom paper size. Click 
Save after specifying the paper width/length and a paper name. If the specified paper 
name already exists on the system, you can update the paper width/length. 
 
Valid Paper Width  : 25.4 mm ~ 72.0 mm 
Valid Paper Length : 25.4 mm ~ 3276.0 mm 

 

 
 
You can choose the new paper size on the Paper Size combo-box after adding a paper 
size. 
 

 
 
Delete button : Deletes the paper size selected in the list. 
Save button : Adds a new paper size or update the paper size selected in the list if the 

paper name already exists on the system. 
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5-1-2 Paper Type 
 
You can choose Receipt or Ticket as paper types. Receipt allows flexible paper length 
according to the data length. Ticket print in fixed length even the print data is short. Default 
setting is “Receipt”. 
 
Receipt : Receipt allows flexible paper length according to the data length. 
Ticket : Ticket print in fixed length even the print data is short. 
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5-1-3 Copies 
 

Copies are printed by specifying the copy count. The copy count is set to 1 by default. Set 
this value bigger than 1 to set the number of copies to print. The value should be within the 
range of 1 to 255. 
 
 
5-1-4 Image Rotation 
 

Image rotation is available for image data only. It means that rotation of device fonts or 
barcode fonts is not supported.  
 
 
5-1-5 Paper Reduction 
 
Reduction function reduces the size of the print image to save print paper. If this function is 
enabled and print-job data includes text data created by using a printer font, device fonts 
are converted to True Type fonts to make them smaller. The barcode size also can be 
reduced by selecting “Enable reducing barcode”. 
 
 
5-1-6 Crop Function 
 
This function crops the upper and lower end of the printing area by the specified number. It 
helps reduce the margin at the top and bottom when there is excessive margin. The value 
should be within the range of 0 to 255. 
 
 
5-1-7 Orientation 
 
Printing orientation can be set to Portrait (which is the default) or Landscape. It is not 
possible to use device fonts and device barcodes in landscape. 
 
Portrait : Printing in the vertical direction. 
Landscape : Printing in the horizontal direction. 
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5-2 Document Settings 
 

 
 

1) Open the Printer Properties window for the corresponding OS. 
 
2) In the General tab, click Preferences (Printing Preferences).  
 
3) Click the Document Settings tab. 
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5-2-1 Send Command 
 
The Windows driver serves to receive the content for print from an application and send it 
to the printer. The “Send Commands” function allows for the addition of desired commands 
at the start or end of the print content. 
 
Start Doc : Addition of command at the beginning of the document. 
Start Page : Addition of command at the beginning of the page. 
End Page : Addition of command at the end of the page. 
End Doc : Addition of command at the end of the document. 
 
For more information about the hexadecimals that can be entered in “Start Doc”, “Start  
Page”, “End Page” and “End Doc”, refer to the Commands Manual. 
 
 
5-2-2 Cash Drawer / Internal Beep 
 

To open a cash-drawer before printing, tick “Open before printing #1” or “Open before 
printing #2”. 
 
To open a cash-drawer after printing, tick “Open after printing #1” or “Open after printing 
#2”. 
 
To make a beep sound when printing, tick “Beep sound before printing” or “Beep sound 
after printing”. 
 
 
5-2-3 Line Feed 
 

It is possible to set the number of line feeds between 0 and 99 for adding blank lines at the 
end of printing. 
 
 
5-2-4 Cut 
 

Paper can be cut at the end of each page or each document (job). 
 
Page/Job : No Cut / No Cut : Paper is not cut after printing. 
Page/Job : No Cut / Partial Cut : Paper is cut at the end of each document (Job). 
Page/Job : Partial Cut / Partial Cut : Paper is cut at the end of each page. 
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5-3 NV Image 
 

 
 

1) Open the Printer Properties window for the corresponding OS. 
 
2) In the General tab, click Preferences (Printing Preferences).  
 
3) Click the NV Image tab. 
 
The position to print NV image stored in the printer can be set at the beginning and/or end 
of the document and beginning and end of each page. Also, there are two commands for 
NV Image printing. Take care of selecting one of the two commands because NV images 
cannot be printed depending on the selected command. 
 

※ NV bit image: “FS p” 

※ NV graphics: “GS ( L” 
 

Start Doc : Insert NV image at the top of the document. 
Start Page : Insert NV image at the top of the page. 
End Page : Insert NV image at the end of the page. 
End Doc : Insert NV image at the end of the document. 
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5-4 Barcode 
 

 
 

1) Open the Printer Properties window for the corresponding OS. 
 
2) In the General tab, click Preferences (Printing Preferences).  
 
3) Click the Barcode tab. 
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5-4-1 1d Barcodes 
 
Windows driver supports one-dimensional barcode fonts as shown in the following table. 
Barcodes can be printed on the printer by using following font names. 
 

Font Name Type (Symbology) Size (Point) Supported Characters 

Barcode1 UPC-A 20 / 40 / 60 / 80 Numeric: 0~9 

Barcode2 UPC-E 20 / 40 / 60 / 80 Numeric: 0~9 

Barcode3 JAN13 (EAN) 20 / 40 / 60 / 80 Numeric: 0~9 

Barcode4 JAN8 (EAN) 20 / 40 / 60 / 80 Numeric: 0~9 

 
Barcode5 Code39 20 / 40 / 60 / 80 

Numeric: 0~9 
Symbols: $, +, -, ., / 

Letters: A~Z 

Barcode6 ITF 20 / 40 / 60 / 80 Numeric: 0~9 

 
Barcode7 Codabar 20 / 40 / 60 / 80 

Numeric : 0~9 
Symbols: $, +, -, ., /, : 

Letters: A~D 

Barcode8 Code93 20 / 40 / 60 / 80 ASCII CODE: 0x00 ~ 0x7F 

Barcode9 Code128 20 / 40 / 60 / 80 ASCII CODE: 0x00 ~ 0x7F 

 
If you want to change the default value of 1d barcode properties, select a Font Name and 
Type of one-dimensional barcode, and then click Properties. Click OK after changing the 
values of properties. 
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5-4-2 2d Barcodes 
 
Windows driver supports two-dimensional barcode fonts as shown in the following table. 
Barcodes can be printed on the printer by using following font names. 
 

Font Name Type (Symbology) Size (Point) 

2D-Code1 PDF417 9.5 

2D-Code2 QR Code 9.5 

 
If you want to change the default value of 2d barcode properties, select a Font Name and 
Type of two-dimensional barcode, and then click Properties. Click OK after changing the 
values of properties for PDF417 or QR Code. 
 

 
 

<PDF417> 
 

 
 

<QR Code> 
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5-5 Dithering 
 

 
 

1) Open the Printer Properties window for the corresponding OS. 
 

2) In the General tab, click Preferences. 
 

3) Click the Dithering tab. 
 
This printer model is a black and white printing device including dithering function, This 
printer model is a black and white printing device including dithering function and 
brightness level adjustment function to produce a sharper or softer image. The following 
dithering algorithms can be selected. 
 
- None  
- Error Diffusion  
- Ordered Dither  
- 4x4 Matrix  
- 8x8 Matrix  
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5-6 Utility 
 

 
 

1) Open the Printer Properties window for the corresponding OS. 
 
2) In the General tab, click Preferences (Printing Preferences).  
 
3) Click the Utility tab. 
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5-6-1 Unified POS Utility 
 
Refer to the Unified POS Utility manual contained in the CD for details. 
  
 
5-6-2 Special Font Edit Utility 
 
The purpose of FontControlA font is not for text printing. It is used to define the printer 
command, assign the defined printer command to a specific ASCII character, and send it 
to the printer. The range of ASCII code that the command can be assigned is from 0x20 to 
0x7F, and the command can be easily assigned using this utility. 
 
1) Click Special Font Edit. 
 
2) Select an ASCII code character and enter the print command. All values should be  

entered in hexadecimal number format. 
 
3) Click Apply and then click OK.  
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5-6-3 Journal Viewer 
 

Journal is a function to save a copy of printed receipts. Copies can be saved without using 
journal printer with this function. Journal saves each printed document in a file and the 
saved file can be viewed by using this utility. 
  
1) Tick Enable Journal to run Journal Viewer, and then click Journal Viewer. 
 

 
 
2) Click Search to set search condition, and then enter Start Date and End Date. 
 
3) Click OK to search the files created within the specified period. 

 

 
 

4) Select the file to print from the list and click Print to send the data stored in the file to 
the printer. 
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5-6-4 Text-Key Function 
 
Text-Key Function is a utility to replace specific text (Text-Key) with other texts or graphic 
images, and to add images to the bottom of receipts. This function can be used only when 
using device fonts. It has no effect when using TTF fonts (True Type Fonts) or the data for 
Text-Key does not exist on a Print-Job.  
 

▶ How to replace Text-Key with other texts. 

 
1) Tick Enable Text-Key Function and then click Text-Key Function. 
 

 
 
2) Click Add New Key, type a text to be used as Text-Key, and then click OK.   
 

 
 

 
 



SRP-350III 

Rev. 1.03 - 35 - 

3) If the Text-Key is selected, The Configuration button is enabled.  
 
4) Click Configuration to enter a text, which is used to replace the selected Text-Key with 

the text entered. For example, if you enter “APPLE” in the text box as below, the Text-
key, “POTATO” can be replaced with “APPLE”. 

 

 
 

▶ How to replace Text-Key with a graphic image and to add it to the bottom of receipts. 

 
1) This utility can also replace the selected Text-Key with a graphic image instead of texts 

and can add a graphic image to the bottom of receipts. It is necessary to add images to 
the image list. 

 
2) Click Add New Image to browse for an image to add to the list. 
 

 
 

3) Enter a unique name to be added, adjust the brightness, select a dithering type, and 
then click OK. Repeat 2 to 3 step to add up to as much as you want.  
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4) Select a Text-Key in the Text-Key list, and then click Configuration.  
 
5) To replace the selected Text-Key with a graphic image, select one of the available 

identifier via the combo box under “Replacement” label. There are two replacement 
functions but only one of the two is available.  

 

  
 

6) In order to print a graphic image to the bottom of receipts, select one of the available 
identifier via the combo box under “Adding a image to the bottom of receipts” label. 
The graphic image for the selected identifier only will be printed if the data for the 
selected Text-Key were found on a Print-Job. 
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5-6-5 Print Preview 
 
This application with a preview of a print-job runs, and windows driver does not directly 
send print-job data to the printer when enabled by clicking “Enable Print Preview”. Print-
job data can only be sent to the printer in the application. The actual output of preview 
image processed by the application might look a little different. 
 
1) Tick Enable Print Preview to make Windows Driver ready for running the application. 
 

 

 
2) When print-job data are created via Windows Driver, the application runs, and then 

loads the data to draw the expected output on screen.   
 

3) Click Print if you want to print, or click Close to exit the application.  
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5-7 Bidirectional Communication 
 

 
 

1) Open the Printer Properties window for the corresponding OS. 
 
2) Click Ports tab.  
 
Because “bidirectional support” is disabled by default, it is necessary to tick Enable 
bidirectional support to get status from the printer. Sample codes contained in the CD 
can help you get more status information than the status information that OS supplies as 
standard way. This windows driver supports only one-on-one communication between the 
printer and host (typically a PC). 
 

Printer status that OS support Printer status that OS does not support 

 
- ONLINE/OFFLINE 
- COVER OPEN/CLOSE 
- PAPER EMPTY 

 
- NEAR END PAPER 
- CASH DRAWER OPEN/CLOSE 
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6. Windows Driver Specifications 
 
6-1 Font 
 
This Windows driver supports various fonts in the following table. Printing using these fonts  
is faster than using Windows fonts provided by the operating system. 
 

Printer Font (Device Fonts) Name Font Size (dot) Font Size (point) 

FontA1x1 FontA1x1[Ext.] FontA1x1[255] FontA1x1(12x24) 9.5 

FontA1x2 FontA1x2[Ext.] FontA1x2[255] FontA1x2(12x48) 19 

FontA2x1 FontA2x1[Ext.] FontA2x1[255] FontA2x1(24x24) 9.5 

FontA2x2 FontA2x2[Ext.] FontA2x2[255] FontA2x2(24x48) 19 

FontA2x4 FontA2x4[Ext.] FontA2x4[255] FontA2x4(24x96) 38.5 

FontA4x2 FontA4x2[Ext.] FontA4x2[255] FontA4x2(48x48) 19 

FontA4x4 FontA4x4[Ext.] FontA4x4[255] FontA4x4(48x96) 38.5 

FontA4x8 FontA4x8[Ext.] FontA4x8[255] FontA4x8(48x192) 77 

FontA8x4 FontA8x4[Ext.] FontA8x4[255] FontA8x4(96x96) 38.5 

FontA8x8 FontA8x8[Ext.] FontA8x8[255] FontA8x8(96x192) 77 

FontB1x1 FontB1x1[Ext.] FontB1x1[255] FontB1x1(9x17) 7 

FontB1x2 FontB1x2[Ext.] FontB1x2[255] FontB1x2(9x34) 13.5 

FontB2x1 FontB2x1[Ext.] FontB2x1[255] FontB2x1(18x17) 7 

FontB2x2 FontB2x2[Ext.] FontB2x2[255] FontB2x2(18x34) 13.5 

FontB2x4 FontB2x4[Ext.] FontB2x4[255] FontB2x4(18x68) 27 

FontB4x2 FontB4x2[Ext.] FontB4x2[255] FontB4x2(36x34) 13.5 

FontB4x4 FontB4x4[Ext.] FontB4x4[255] FontB4x4(36x68) 27 

FontB4x8 FontB4x8[Ext.] FontB4x8[255] FontB4x8(36x136) 54.5 

FontB8x4 FontB8x4[Ext.] FontB8x4[255] FontB8x4(72x68) 27 

FontB8x8 FontB8x8[Ext.] FontB8x8[255] FontB8x8(72x136) 54.5 

FontC1x1 FontC1x1[Ext.] FontC1x1[255] FontC1x1(9x24) 9.5 

FontC1x2 FontC1x2[Ext.] FontC1x2[255] FontC1x2(9x48) 19 

FontC2x1 FontC2x1[Ext.] FontC2x1[255] FontC2x1(18x24) 9.5 

FontC2x2 FontC2x2[Ext.] FontC2x2[255] FontC2x2(18x48) 19 

FontC2x4 FontC2x4[Ext.] FontC2x4[255] FontC2x4(18x96) 38.5 

FontC4x2 FontC4x2[Ext.] FontC4x2[255] FontC4x2(36x48) 19 

FontC4x4 FontC4x4[Ext.] FontC4x4[255] FontC4x4(36x96) 38.5 

FontC4x8 FontC4x8[Ext.] FontC4x8[255] FontC4x8(36x192) 77 

FontC8x4 FontC8x4[Ext.] FontC8x4[255] FontC8x4(72x96) 38.5 

FontC8x8 FontC8x8[Ext.] FontC8x8[255] FontC8x8(72x192) 77 
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Printer Fonts are defined as follows. 
 

1) FontA1x2 
- ANSI Character code support (Code Page 1252) 
- Font size (dot): 12 x 48 (Double height) 
- Font size (point): 19 

 
2) FontA1x2 [Ext.] 

- IBM expansion Character code support (Code Page 437)  
- Font size (dot): 12 x 48 (Double height) 
- Font size (point): 19 

 
3) FontA1x2 [255] 

- Buyer exclusive code support (User Code page)  
- Font size (dot): 12 x 48 (Double height) 
- Font size (point): 19 
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6-2 Special functions 
 
This Windows driver supports the special functions as shown in the following table. 
Select FontControl font first and use the characters in the table to use the special 
functions. Take care as this function is not for printing general texts. 
 

Character Special Function 

5 Prints HT (0 x 09) 

6 Prints LF (0 x 0A) 

7 Prints CR (0 x 0D) 

a Open Drawer 2 (50ms drive pulse width) 

b Open Drawer 2 (100ms drive pulse width) 

c Open Drawer 2 (150ms drive pulse width) 

d Open Drawer 2 (200ms drive pulse width) 

e Open Drawer 2 (250ms drive pulse width) 

f Open Drawer 2 without paper feeding (50ms driver pulse width) 

g Cut Receipt (partial cut) without paper feeding 

i Prints the NV Image saved in the 00 address (double-size) 

j Prints the NV Image saved in the 01 address (double-size) 

k Prints the NV Image saved in the 02 address (double-size) 

l Prints the NV Image saved in the 03 address (double-size) 

m Prints the NV Image saved in the 04 address (double-size) 

p Does not add HRI characters to the barcode 

q Adds HRI characters in Font A above the barcode 

r Adds HRI characters in Font A below the barcode 

s Adds HRI characters in Font B above the barcode 

t Adds HRI characters in Font B below the barcode 

u Turns white/black reverse printing mode on 

v Turns white/black reverse printing mode off 

w Aligns text to the left 

x Aligns text to the center 

y Aligns text to the right 

A Open Drawer 1 (50ms drive pulse width) 

B Open Drawer 1 (100ms drive pulse width) 

C Open Drawer 1 (150ms drive pulse width) 

D Open Drawer 1 (200ms drive pulse width) 

E Open Drawer 1 (250ms drive pulse width) 

F Open Drawer 1 without paper feeding (50ms driver pulse width) 

G Prints the NV bitmap saved in the 00 address 

H Prints the NV bitmap saved in the 01 address 

I Prints the NV bitmap saved in the 02 address 

J Prints the NV bitmap saved in the 03 address 

K Prints the NV bitmap saved in the 04 address 

P Cut Receipt (partial cut) 

R Prints the NV Image saved in the 00 address 

S Prints the NV Image saved in the 01 address 

T Prints the NV Image saved in the 02 address 

U Prints the NV Image saved in the 03 address 

V Prints the NV Image saved in the 04 address 
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Character Special Function 

[ Prints the NV bitmap saved in the 00 address (double-size) 

] Prints the NV bitmap saved in the 01 address (double-size) 

^ Prints the NV bitmap saved in the 02 address (double-size) 

_ Prints the NV bitmap saved in the 03 address (double-size) 

` Prints the NV bitmap saved in the 04 address (double-size) 

 
1) Example 
 
Select FontControl font and send 6 for “LF” (Line Feed) operation (instead of printing 
character “6”).  
 
2) FontControl font functions. 
 

Font Name Special Functions Font Size (point/dot) 

FontControl 

Open Drawer 1/2 
Cut receipt 

Cut receipt(without paper feeding) 
Justification (Left/Center/Right) 

Output HT, Output LF, Output CR 
Barcode Printing 

Print NV Graphic Data 

(9.5 / 12x24) 

 



SRP-350III 

Rev. 1.03 - 43 - 

7. Use of Windows Driver 
 
7-1 Use of Visual Basic 
 
This section contains example codes to control the printer using Windows driver with 
Visual Basic. Sample programs are included in the CD. 
 
7-1-1 Windows Driver Selection 
 
The following example code explains how to select “BIXOLON SRP-350III” Windows driver. 
 

 
For Each prnPrinter In Printers 
 
If prnPrinter.DeviceName = “BIXOLON SRP-350III” Then 
 
Set Printer = prnPrinter 
 
Exit For 
 
End If 
 
Next 

 

 
 

7-1-2 Text Printing 
 
The following example code explains how to print texts using Windows Fonts and Device 
Fonts. 
 

 
‘Print in Windows font 
Printer.FontSize = 9 
Printer.FontName = “Arial” 
Printer.Print “Arial Test”  
 
‘Print in printer font 
Printer.FontSize = 9.5 
Printer.FontName = “FontA1x1” 
Printer.Print “FontA1x1 Font”  
 
Printer.EndDoc 
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7-1-3 Barcode Printing 
 
The following example code explains how to print the barcode (JAN8 (EAN)). 
 

 
'Print Bar Code. 
Printer.FontSize = 20 
 
Printer.FontName = "Barcode4" 
Printer.Print "1234567" 
 
Printer.EndDoc 

 

 
The following example code explains how to print the 2D barcode (PDF417). 
 

 
'Print Two-dimensional Codes. 
Printer.FontSize = 9.5 
 
Printer.FontName = "2D-Code1" 
Printer.Print "Print Test PDF417" 
 
Printer.EndDoc 
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7-2 Use of WordPad 
 
7-2-1 WordPad Environment Settings 
 
Launch WordPad, set the printing related options as follows, and test the printer with 
WordPad. 
 

- Select printer 
Select “Print” from the “File” menu, and select the printer (BIXOLON SRP-350III). 

 
- Set paper size, orientation, margin, etc. 

Select the “Page Setting” from “File” menu, and set paper size, orientation, and margin. 
 
 
7-2-2 Text Printing 
 
Print the text from WordPad using the Windows driver of the printer. 
 

 
 
1) Select the font from the font selection box (FontA1x1). 
 
2) Select the point size from the point selection box (9.5). 
 
3) Enter the text to print. 
 
4) Click the Print icon in the toolbar to print the text. 
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